
Basisinstructies : Illustrator voor Lasercutting.

Opstarten

1.  Open Illustrator.  
2.  Klik op File->New, onderstaand tabblad verschijnt (afb 1).  Hiermee creëert u een nieuw artboard (werk-
blad) in Illustrator.  

3.  Volgende instellingen voor het creëren van een artboard zijn van belang : 
	 -De maximale afmetingen die de Trotec lasercutter kan snijden/graveren is 800 mm (lengte) en 500 
	 mm (breedte), geef afmetingen in die kleiner of gelijk zijn aan deze waardes.  
	 -Millimeter is de standaardmaat voor lasercutting.  
	
	 -Belangrijk : Zorg er steeds voor dat uw Artboard altijd in RGB-kleurmodus wordt aangemaakt, 
	 CMYK-modus zoals bij de Print-preset wordt verkeerd geïnterpreteerd door de lasercutter.  Om 
	 fouten in uw ontwerpkleuren te vermijden kiest u dus het best nooit voor de optie ‘Print’ en altijd 	
	 voor ‘Art & Illustration’.

	 -Druk op Create van zodra u de instellingen hebt aangepast.  Een nieuw artboard verschijnt.  

Tip : Indien u een eerder in CMYK-modus gemaakt ontwerp wil gebruiken om te laseren, is het dikwijls 
handiger om een nieuw artboard aan te maken in RGB-modus, het oorspronkelijke ontwerp te copy-pasten 
en de kleuren om te zetten naar RGB.  

Afb 1 : tabblad nieuw document.  



Ontwerprichtlijnen.

Creëer uw ontwerp.  Hou daarbij rekening met volgende richtlijnen : 

1.  RGB-zwart (R=0, G=0, B=0) wordt standaard gebruikt om te graveren.  Ook lijnen (Stroke) kunnen 
gegraveerd worden met de aangegeven dikte.  Indien gewenst kan u ook de opacity aanpassen, waardoor het 
zwart minder krachtig wordt gegraveerd (o.a. interessant voor glas).   In principe kan u ook andere (RGB-)
kleuren gebruiken om te graveren.  U kan uw vormen en lijnen een kleur geven door bovenaan op uw 
scherm één van de twee of beide vierkantjes aan te klikken.  Automatisch verschijnt een kleurenpalet.  De 8 
RGB-hoofdkleuren staan bovenaan.  U vindt de RGB-waardes en de andere kleurwaardes die de machine 
erkent achteraan dit document.  

	 Opgelet : CMYK-zwart heeft niet dezelfde kleurwaarde als RGB-zwart, de Trotec-laser 
	 beschouwt het als een grijze kleur.  

Tip : Graveren wordt altijd gedaan voor het snijden.  Het uigesneden ontwerp zakt immers geregeld een 
beetje weg en dat kan tot onscherp graveren of graveren op de verkeerde plaats leiden.  

U kan zowel vector- als rasterafbeeldingen graveren.  Voor het importeren van rasterafbeeldingen geschikt 
om te lasergraveren, raadpleeg de ‘Basisinstructies : Photoshop voor Lasergraveren’.  Voor complexe 
opdrachten waarbij binnen één ontwerp op verschillende manieren gegraveerd moet worden, kunt u ook 
andere RGB-kleuren aanduiden om te graveren.  Zie daarvoor ‘Basisinstructies : JobControl’.  
Rasterafbeeldingen -zoals bv foto’s- zijn opgebouwd uit pixels.  Bij uitvergroting worden die pixels zichtbaar.  
Bekende bestandsformaten zijn o.a. JPEG, TIFF, PNG, BMP, GIF,...  Vectorafbeeldingen zijn daarentegen 
opgebouwd uit geometrische vormen en kunnen in principe oneindig vergroot worden zonder dat de 
afbeelding blokkerig of wazig wordt.  Bestandsformaten zijn onder andere AI, CDR, SVG, DXF, DWG,...  
PDF kan u zowel voor rasterafbeeldingen als voor vectorafbeeldingen gebruiken.  U kan rasterafbeeldingen 
importeren in een vectorbestand, hou er echter rekening mee dat ze niet automatisch omgezet worden in 
vectoren.  Bij vergroting zullen de pixels te zien blijven.  

Afb. 2 : RGB-zwart voor graveren.  



2.  De eerste keus voor snijden is RGB-rood (R=255, G=0, B=0).   Klik op het vierkantje naast Stroke en klik 
dan op RGB-rood.  Om een lijn te snijden dient u de waarde van 0,001 mm aan die lijn te geven.  Omdat 
Illustrator zulke dunne lijnen enkel bij sterke vergroting weergeeft, is het meestal handiger om de lijnen in 
aanvang iets dikker te maken en bijvoorbeeld een waarde van 0,1 mm te geven.  Vergeet de dikte niet om te 
zetten naar 0,001 mm eens uw ontwerp klaar is.  

	 Opgelet : Indien u de lijn niet de dikte van 0,001 mm geeft, dan interpreteert de laser haar 
	 als een te graveren lijn en wordt het rood omgezet in een grijswaarde.  Hetzelfde gebeurt 
	 wanneer u CMYK-rood of een andere roodwaarde zou gebruiken.  

Afb. 3 : RGB-rood voor snijden.  



3.  Gecombineerde geometrie.  De Trotec-lasermachine herkent vormen binnen vormen.  U kan dus RGB-
rode snijlijnen gebruiken binnen  andere rode snijlijnen, de machine zal automatisch de interne lijnen eerst 
snijden.  Bij vormen die elkaar overlappen lukt dit echter niet.  Als de volgorde waarin gesneden wordt van 
belang is, dient u één van de vormen een andere kleur toe te kennen, bijvoorbeeld RGB-blauw (R=0, G=0, 
B=255).  Ook bij complexe opdrachten kan het raadzaam zijn om meerdere RGB-kleuren te gebruiken.  

4.  Vouwlijnen/esthetische lijnen.  Indien u een ontwerp heeft waarin de lijnen niet volledig door het mate-
riaal heen moeten snijden (bijvoorbeeld vouwlijnen voor papier) dan kan u aan deze lijn een andere RGB-
kleur geven, bijvoorbeeld RGB-groen (R=0, G=255, B=0).  Ook deze lijnen dienen een dikte van 0,001 mm te 
hebben, anders worden ze gegraveerd.  

Afb. 4 : geometrie binnen geometrie.  De machine snijdt eerst de cirkel, 
daarna pas het vierkant.  

Afb. 5 : overlappende geometrie.  Om te bepalen welke vorm eerst 
gesneden wordt, geeft u beide vormen een andere kleur.  

Afb. 6 : vouwlijn in RGB-groen.  



5.  Lasersnijden en gedrukte media.  De lasersnijder is voorzien van een camera die punten kan herkennen, 
waardoor het mogelijk wordt voorgedrukte ontwerpen exact uit te snijden.  Daarvoor dient u een aantal 
stappen te nemen.
Maak of voer uw ontwerp in in Illustrator.  Bepaal de snijlijnen, bij voorkeur in RGB-rood met een dikte van 
0,001 mm en zet ze op een aparte laag.  Plaats rond uw ontwerp minimum 3 RGB-zwarte cirkels van 6 mm 
doorsnee.  De lijndikte van de cirkels dient 0,001 mm in RGB-zwart te zijn.  Voor complexe ontwerpen of 
meerdere aparte uitsnedes plaatst u meer zwarte cirkels.  Plaats de cirkels op een aparte laag om het overzicht 
over de structuur van uw bestand te bewaren.  Van zodra uw ontwerp klaar is, kan u uw bestand laten 
drukken, dit zonder de rode snijlijnen maar met de zwarte cirkels.  Eens gedrukt mag u vanzelfsprekend de 
plaats van de cirkels ten opzichte van het ontwerp niet meer veranderen.  De print kan in de machine gelegd 
worden, het bestand kan nu met de snijlijnen geactiveerd naar de lasersnijder gestuurd worden.  De camera 
zal de cirkels herkennen en de snijlijnen exact uitsnijden.   Let er zeker op dat de RGB-zwarte lijnen rond de 
RGB-zwarte cirkels zichtbaar zijn voor de computer.  

Afb.  7 : Ontwerp klaargezet voor print.  4 RGB-zwarte cirkels van 6mm doorsnee met lijn van 0,001mm.  Cirkels, snijlijnen en printontwerp 
elk op een aparte laag.  Voor het printen worden de snijlijnen onzichtbaar gemaakt (het oogje uitschakelen.    

Afb.  8 : Zelfde ontwerp klaargezet voor lasersnijden.  4 RGB-zwarte cirkels van 6mm doorsnee met lijn van 0,001mm op exact dezelfde 
plaats.  Snijlijnen zichtbaar maken en printontwerp onzichtbaar maken door op het oogje te klikken.  



6.  Enkele tips voor een goed opgebouwd en geslaagd lasercutontwerp :
-Het kan handig zijn -zeker bij complexe ontwerpen- om een kladversie te maken met allerlei mogelijke 
constructielijnen en andere hulpmiddelen zoals ingescande voorontwerpen, ruw geschetste plannen,...  
Bewaar deze kladversie, start een nieuw bestand op, copy-paste de elementen die u wil laseren en zet ze 
laserklaar volgens de instructies hierboven.  Blijkt er nog een fout in uw ontwerp te zitten, dan kan u altijd 
terugvallen op uw kladversie...   

-Maak er een goede gewoonte van uw ontwerpen duidelijk te structureren.  Zeker voor complexe ontwerpen 
is het handig om een duidelijk overzicht te hebben van wat gegraveerd en gesneden moet worden en op 
welke manier, zowel voor uzelf als voor diegenen met wie u eventueel moet samenwerken om uw ontwerp 
te realiseren.  Een handig hulpmiddel hierbij is het layer panel (lagenpaneel), dat u in staat stelt uw ontwerp 
bijvoorbeeld op te splitsen in lagen op basis van de RGB-kleur.  De volgorde is in de meeste gevallen niet van 
belang.

Afb. 9 : duidelijke structuur in het lagenpaneel.  

-Vermijd het om lijnen die u niet wil snijden te bedekken met een (RGB) wit vlak.  Het is beter om lijnen die 
niet gesneden worden te verwijderen of minstens onzichtbaar te maken (via de oogjes aan het layer panel).  
Het gebeurt zelden maar bij complexe opdrachten met meerdere kleurcodes durft de machine bedekte lijnen 
soms toch te snijden.  Hetzelfde gaat op voor fotogravures : het is beter eventuele maskers aan te brengen in 
Photoshop en uw bestand afgewerkt te importeren, dan in illustrator een masker aan te brengen (zie hiervoor 
‘Basisinstructies : Photoshop voor Lasercutting’).  Ook hier kan het bij complexe opdrachten gebeuren dat de 
machine het in Illustrator aangebrachte masker negeert.  

-Guidelines worden niet gesneden, maar om misverstanden te voorkomen is het beter om ze onzichtbaar te 
maken of eventueel te verwijderen, zeker wanneer u RGB-cyaan zou gebruiken in uw ontwerp.  Plaats ze voor 
de duidelijkheid ook altijd op een aparte laag.  



-Vermijd dubbele (snij)lijnen, de machine interpreteert dat als een opdracht om de lijn tweemaal te snijden, 
wat resulteert in een dikkere effectief gesneden lijn en meer snijtijd.  Wanneer u twee objecten aan elkaar 
vastmaakt, zorg dan altijd dat u één van beide aangrenzende lijnen verwijdert.  Controleer ook altijd of het 
gebruik van de pathfinder niet tot dubbele lijnen heeft geleid.  

Afb. 10 : Constructie van aaneensluitende vlakken.  

-De laser snijdt erg fijn, maar er blijft een dunne snijlijn.  Wilt u dat onderdelen perfect op elkaar passen, 
zoals bijvoorbeeld voor een puzzel, dan dient u daarvoor te compenseren.  De compensatie is afhankelijk van 
het soort materiaal, de dikte daarvan en de vorm van uw ontwerp.  Bij papier is het bijvoorbeeld verwaar-
loosbaar, bij MDF van 2mm gaat het om ongeveer 0,2mm.  Afhankelijk van uw ontwerp kan u dat doen via 
Object->Transform->Scale, via Object->Path->Offset Path of via de Vorm-afmetingen.  

Afb. 11 : Voorbeeld van compensatie voor uitsparingen, in dit geval voor MDF van 2mm.   

-Vermijd een ontwerp waarvan de (snij)lijnen in stukken opgebroken zijn, ook al ziet het er voor u één lijn 
uit.  De laser zal die aparte lijnen ook  zo interpreteren en schijnbaar willekeurig van hot naar her springen 
in plaats van de lijn in één beweging te laseren.  Dit kan negatieve gevolgen hebben op de snijkwaliteit en 
de snijtijd.  Of de lijnen/paden in uw ontwerp uit één stuk dan wel uit meerdere stukken bestaan, kan u 
controleren in het lagenpaneel.  U kan de lijnen met elkaar verbinden door middel van het ‘Direct selection 
tool’ (het witte pijl-icoontje) of het ‘Pen tool’ (het vulpen-icoontje).  Selecteer twee eindpunten van lijnen die 



u met elkaar wil verbinden.  U kan nu het icoontje ‘Connect selected end points’ (twee vierkanjes verbonden 
met een kromme stippellijn) aanklikken, de twee lijnen worden één lijn.  De sneltoets voor dit commando is 
CTRL-J.  Wanneer het icoontje grijs blijft, hebt u mogelijk meer dan twee punten geselecteerd of zitten beide 
lijnen in een andere groep.  Het verbinden van de lijnen is ook een handige manier om te controleren of u 
per ongeluk geen dubbele lijnen of losse punten hebt staan in uw ontwerp.  

Afb. 12 : Onderbroken (snij)lijnen en hoe die te vermijden.

Afb. 13 : het bepalen van start- en eindpunt.

-Illustrator heeft een belangrijk nadeel : het startpunt/eindpunt van een gesloten lijn wordt niet duidelijk 
weergegeven, waardoor het aanpassen ervan makkelijk vergeten wordt en de machine op een schijnbaar 
willekeurig punt lijkt te starten en te stoppen.  Als dit in het midden van een lijn gebeurt en niet op een 
hoekpunt, is dat zichtbaar in het eindresultaat als een kleine oneffenheid.  U kan echter zelf bepalen waar 
uw startpunt komt.  Maak weerom gebruik van het ‘Direct selection tool’ of van het ‘Pen tool’ om een punt 
te selecteren.  In het voorbeeld van afbeelding 11 heeft één van de twee hoekpunten de voorkeur, de andere 
punten kan u beter niet gebruiken.  Kies een hoekpunt en klik dan op het icoontje ‘Cut path at selected 
anchor point’ (een schaartje met twee vierkantjes verbonden door een kromme).  Selecteer beide eindpunten 
die u daardoor gecreëerd hebt en klik op het icoontje ‘Connect selected end points’ naast ‘Cut path at selected 
anchor point’.  Het start- en eindpunt ligt nu op het gekozen hoekpunt.
Wanneer er in uw ontwerp geen hoekpunten of scherpe bochten zijn zoals in een cirkel, kan het een optie 
zijn om de lijn door te knippen op een bepaald punt en met het ‘Pen tool’ een extra lijn aan de cirkel toe te 
voegen.  Afhankelijk van het ontwerp kan dit zowel naar binnen als naar buiten.  



7.  Addendum : RGB-kleuren.  Hieronder vindt u de RGB-kleuren die de Trotec-machine herkent.  De 
waarden dienen exact ingegeven te worden.  Er zijn nog enkele andere kleuren die de machine herkent, maar 
om een kleurboek te vermijden beperken we ons tot de standaardwaarden.  Indien u toch een dermate com-
plex ontwerp heeft dat zoveel kleuren kan gebruiken, geef dan een seintje aan de begeleider.  Bekijk ook of het 
niet handiger is om het ontwerp in verschillende stappen te snijden/graveren.   

RGB-Zwart : R=0, G=0, B=0 RGB-Rood : R=255, G=0, B=0

RGB-Blauw : R=0, G=0, B=255RGB-Groen : R=0, G=255, B=0

RGB-Magenta : R=255, G=0, B=255 RGB-Cyaan : R=0, G=255, B=255

RGB-Geel : R=255, G=255, B=0 RGB-Geen : R=/, G=/, B=/


